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1 About this manual
Welcome to Telelogic® DOORS for ClearCase Interface™.
Telelogic DOORS for ClearCase Interface transfers data between Telelogic® 
DOORS® (DOORS) and ClearCase®. It lets you synchronize configuration 
management regimes and establish traceability between information managed in 
DOORS and versions managed by ClearCase.
This manual describes how to use version 2.1 of Telelogic DOORS for 
ClearCase Interface. It assumes that you know how to use both DOORS and 
ClearCase.

Typographical conventions
The following typographical conventions are used in this manual:

Related documentation
The following table describes where to find information in the documentation 
set:

Typeface or 
Symbol

Meaning

Bold Important items, and items that you can select, including 
buttons and menus. For example: Click Yes to continue.

Italics Book titles

Courier Commands, files, and directories; computer output. For 
example: Edit your .properties file.

> A menu choice. For example: Select File > Open. This means 
select the File menu, then select the Open command from it.

For information on See

How to use DOORS The Telelogic DOORS documentation 
set

How to use ClearCase The ClearCase documentation set
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You'll find PDF versions of the DOORS manuals on:

• The Telelogic Lifecycle Solutions DVD

• The Support website https://support.telelogic.com

What’s new in version 2.1 of Telelogic 
DOORS for ClearCase Interface

The Telelogic DOORS for ClearCase 
Interface readme file

How to install Telelogic DOORS for 
ClearCase Interface

Telelogic DOORS Installation Guide

For information on See
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2 Concepts
This chapter introduces Telelogic DOORS for ClearCase Interface and explains 
the concepts you need to understand before you use it:

• About Telelogic DOORS for ClearCase Interface

• About Telelogic DOORS for ClearCase Interface functions

About Telelogic DOORS for ClearCase Interface
DOORS is the world’s leading tool for creating, structuring, and managing 
complex sets of requirements, such as those for a typical software development 
project. ClearCase from Rational Software Corporation is a source code control 
and configuration management system. 
Telelogic DOORS for ClearCase Interface is a bridge between these two 
products, enabling complete lifecycle traceability from requirements through to 
configuration management.
Telelogic DOORS for ClearCase Interface allows software project teams to:

• Establish traceability from DOORS information to specific elements, 
branches or versions in ClearCase.

• Import release information from ClearCase to DOORS.

• Import merge information from ClearCase to DOORS.

• Import ClearCase attributes to DOORS.

• Create DOORS baselines to match ClearCase labels.

• Navigate through all ClearCase elements, versions and branches in one 
window.

• Generate complete reports on combined ClearCase and DOORS 
configuration status.

About Telelogic DOORS for ClearCase Interface functions
Telelogic DOORS for ClearCase Interface provides two functions that are 
fundamental to integrating configuration management with lifecycle traceability, 
as follows:

• The ability to represent the configuration item structure stored in ClearCase 
as a DOORS module.
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Each element, branch and version in a Versioned Object Base (VOB) is 
represented by a DOORS object in a hierarchy that represents the complete 
version tree for the VOB. Merge hyperlinks are stored as DOORS links.

Once you have represented the ClearCase configuration item structure in a 
DOORS module, you can use regular DOORS link functions to establish 
traceability from project information stored in DOORS to the configuration 
items. For example, a ClearCase version object that implements a specific 
requirement can be directly linked to the corresponding DOORS 
requirement object. This allows you to demonstrate conformance to 
requirements at source-code level.

• The ability to baseline DOORS modules using the same labels and 
comments as the ClearCase data.

This operation uses another DOORS module to store a list of labels that 
exist in each VOB, and to create baselines automatically for groups of 
modules. Each baseline is recorded in the DOORS module, providing a 
configuration-management record of which DOORS baselines relate to 
which ClearCase labels. This function also provides the important ability to 
create baselines for many DOORS modules simultaneously.

These two functions create a unified approach to both traceability and 
information release control, resulting in full lifecycle traceability and rigorous 
configuration management.
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3 Importing from ClearCase
This chapter describes:

• Importing from ClearCase into DOORS

• Viewing new information

• Understanding imported information

• Using DOORS traceability

• Import exceptions

Importing from ClearCase into DOORS
This operation reads the complete structure of a VOB into a DOORS module, 
creating a DOORS object for each element, version and branch. Properties, 
attributes and labels are also imported.
Access to ClearCase elements is controlled by views that determine which 
elements, branches and versions are visible. ClearCase provides dynamic and 
snapshot views, depending on whether you want the views to be updated 
automatically or manually. Views also control access to derived objects and 
view-private files.
For these reasons it is vital that you choose the correct view for your import 
operation. Although Telelogic DOORS for ClearCase Interface imports all 
versions and branches, it cannot import view-private files from all views, so you 
must decide which view to use if you want these to be imported.
Telelogic DOORS for ClearCase Interface uses Windows® drive letters to select 
views. You can either choose to use the Dynamic-views drive, normally M:, or 
a view representing a specific dynamic or snapshot view. The dynamic views 
drive allows you to select any view of any VOB without needing to choose a 
drive letter, simplifying the import operation.

Importing structures for the first time

You can choose to import into an empty module or into a module that already 
contains objects. Each VOB is always imported under its own top-level object.
Normally, you want to maintain your configuration item structure in a special 
module. However, you might want to store information for several VOBs in the 
same module. If you choose to do this, the new VOB is imported under a new 
top-level object at the end of the module.
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To import from ClearCase:
1. Open the target DOORS module.

2. From the DOORSConnect menu, select ClearCase > 
Synchronize/import.
Note  A command prompt window (DOS box) is displayed 

briefly before the Telelogic DOORS for ClearCase 
Interface Import Structure window displays. This 
happens when Telelogic DOORS for ClearCase 
Interface is communicating with ClearCase, and occurs 
several times during the import process. Each time, the 
command prompt window disappears automatically 
when the process is complete.

3. If you want to import from a dynamic view, make sure that the Drive field 
contains the correct drive. M: is the ClearCase default.

4. Select the view in the View field.

5. Select the VOB in the VOB field. The Path field shows the composite path 
that you have created.

Only mounted VOBs and views are shown. If you do not see the VOB or 
view you want to import, click Close to quit Telelogic DOORS for 
ClearCase Interface, then use ClearCase to mount the required VOB and 
view. 
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Importing from ClearCase into DOORS

6. If you want to import from a snapshot view or a dynamic view mounted on 
a specific drive, select Specific view drive from the Type drop-down list.

7. Select the correct drive and VOB. The Path field shows the composite path 
that you have created. 

Only mounted VOBs are shown. If you do not see the VOB you want to 
import, click Close to quit Telelogic DOORS for ClearCase Interface and 
use ClearCase to mount the required VOB. 

8. Clear the Create merge links in box if you do not want to create DOORS 
links representing ClearCase merge hyperlinks. 

9. If you want to create links in the default link module, ClearCase Merges, and 
it does not exist, it is created automatically the first time you perform an 
import. In this case, go to step 11. 

10. If you want to create links, but not in the default link module, click Select to 
display the Select Link Module window.

11. Select the link module you want to use, and click Select.
12. Click Import to start the import operation.

Several command prompt windows appear briefly as the operation 
progresses.
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When the import is complete, an import report is displayed.

The import report shows how many new items were created during the 
import, how many items were updated, how many were deleted and how 
many merge links were created. 

For information on how to use the report window functions, see “Viewing 
new information,” on page 10.

Re-importing structures

It is likely that your ClearCase data will continue to evolve after you have 
imported it into DOORS. Telelogic DOORS for ClearCase Interface can 
synchronize imported data with the state of the ClearCase VOB, adding new 
elements, versions and links and updating attributes and labels as required.
To synchronize your imported data, select the DOORS object representing the 
VOB to be re-imported and repeat the procedure in “Importing structures for 
the first time,” on page 5. This object appears at the top of the structure, usually 
the first object in the module. An import report is displayed, showing the 
number of items that have been created or updated.

If an item is deleted from the VOB, the equivalent object in the DOORS 
surrogate module is flagged with the attribute CC Deleted set to True.
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Importing from ClearCase into DOORS

Items that are moved within the VOB, for example a source file moved from one 
directory to another are moved within the DOORS surrogate module. This 
allows traceability to be maintained. 

Imported attributes for structures 

ClearCase data is stored in DOORS attributes when it is imported. Attributes 
that store ClearCase data start with CC.
ClearCase properties are stored in the following attributes:

Telelogic DOORS for ClearCase Interface also imports ClearCase labels and 
attributes. These are stored as DOORS attributes and the values are kept with 
each DOORS object.
If you have a ClearCase label Release_1, a DOORS Boolean attribute called CC 
Label Release_1 is created. All versions that are marked with that label have the 

Attribute Contains

Object Heading The name of the ClearCase element. For a version this 
contains just the tail of the version name. For example, if the 
extended name of a version is: 
sysdef.c@@\main\windows\5 
the Object Heading attribute contains 5.

Object Text The ClearCase comment for the element, branch or version. 
This typically contains the comment from a source file 
check-in.

CC Kind The type of the object. Possible values are VOB, Directory, 
File, Version, Branch, Derived Object, or Private File.

CC Full Name The full version name of an item. In the example above this 
attribute would contain sysdef.c@@\main\windows\5.

CC User The name of the person who created the element, version or 
branch.

CC Date The date on which the element, version or branch was created.

CC Merges The full name of a version to which this version has been 
merged.

CC DBID The ClearCase database identifier for the item.
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DOORS attribute set to True. A simple DOORS filter immediately shows which 
items belong to each release.
If you have a ClearCase attribute QA_Status, a DOORS string attribute called 
CC Attr QA_Status is created. When an element, branch or version has a value 
for this attribute it is copied into the DOORS attribute.
Telelogic DOORS for ClearCase Interface also creates three attributes to store 
import metadata: CC Deleted, CC New, and CC Updated. These are set each 
time you import or synchronize, and are the basis for the import report filters. 
You can create your own filters and views based on these attributes.

Viewing new information
DOORS provides many useful ways of viewing imported ClearCase 
information. It has the advantage of being able to put all the relevant 
information into a single screen.

Any updated information is clearly shown using the standard DOORS change 
bars. After an import, new or updated items have their change bars set to red, 
but the rest of the objects remain unmodified. For example, in the illustration 
above you can see two objects that have recently been labeled as being part of 
Release 1.1. 
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Viewing new information

In the case of a re-import, you can use the New items, Updated items and 
Deleted items buttons in the Telelogic DOORS for ClearCase Interface Import 
Report window to show only the items that were new, updated or deleted.

The following screenshot shows the data with a new or updated filter applied:

ClearCase information can also be shown in graphics mode, where colors are 
used to distinguish the different kinds of object. Merge links are clearly shown if 
you click View, then Show, then Graphics Links. This option is automatically 
switched on by the Graphics button in the ClearCase Import Report window.
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The following screenshots show the same information in graphics mode, first 
without then with the filter to select new and updated items:
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Understanding imported information

Understanding imported information 
This section explains how to interpret the information and how to get the best 
from it.

Version structure
ClearCase version structures are represented as version hierarchies, written using 
an extended filename syntax, such as the following name:

lookup.c@@main\PERFORMANCE\5
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This means that this is the fifth version of the file lookup.c in the PERFORMANCE 
branch. In ClearCase this structure can be seen graphically element by element 
when using the Version Tree utility.

DOORS stores this information as a hierarchy of objects containing the names 
of the elements, branches and versions as headings, with check-in comments as 
the text.
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Understanding imported information

The following screenshot shows the same information in the DOORS column 
view:

You can see the relationship between the DOORS names and the ClearCase full 
name shown in the right-hand column.
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The following picture is the same module displayed in graphics mode, again 
providing a clear view of the relationship between versions:

The DOORS graphics mode has the advantage over the ClearCase Version Tree 
of showing many version trees at once.

Graphics colors

When each item is imported it is assigned a color for use in graphics mode. This 
helps provide instant visual recognition of the structure of your data.
The color allocations are as follows:

ClearCase attributes
All user-defined ClearCase attributes are imported into DOORS as string 
attributes with the same name, prefixed with CC Attr. For example, the 
ClearCase attribute Test_Status is called CC Attr Test_Status in DOORS.

Kind Color

VOB Red

Directory Green

File Blue

Version Light blue

Branch Yellow

Derived Object Pink

Private File Orange
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Understanding imported information

Attribute values are imported for all ClearCase elements, versions and branches. 
If the values of attributes are subsequently changed in ClearCase, the values in 
DOORS are updated the next time the file is imported. 

Labels

ClearCase labels are typically used to mark which files were included in a 
particular release. Labels have names, such as Patch_1.1. The import process 
creates a Boolean label for each imported label, prefixing the label name with CC 
Label. For this example, the Boolean label would be CC Label Patch_1.1.
Each version that is labeled with a given name, has the DOORS attribute set to 
True. This can be used in filters, and gives instant indications of what versions 
were used in a given release. 
The following screenshot shows an example of a label filter, set up by filtering on 
CC Label Release_1 equals True:
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Merge links

ClearCase uses hyperlinks to indicate where files have been merged. These can 
be imported into DOORS as regular DOORS links. This import process is 
optional, and can be turned off using the Create merge links check box.
Links are created from the version to the one it is merged with, typically from a 
branch to the main stream. This is equivalent to the direction of the ClearCase 
hyperlinks.
The best way of viewing merge links is to turn on the display of graphics links by 
clicking View, then Show, then Graphics Links. Alternatively, all the normal 
DOORS link viewing and analysis mechanisms are available.
The following picture shows a screen fragment showing \main\FIXES_1\1 
merged with \main\3:

Using DOORS traceability
Once imported into DOORS, the ClearCase structure can be treated as normal 
in DOORS. This means that the ClearCase structure can be included in your 
traceability schema. A typical application of this is to link source code modules 
to requirements in order to check which requirements have been met. This is 
only one case where traceability could be useful, as outlined below.

Managing links

You can use any of the standard methods for creating links between ClearCase 
configuration items and other DOORS information: 

• Drag and drop

• Link > Create links
• Link module matrix

In each case you must take into account the correct direction for links to allow 
impact and traceability analyses to be performed as required. These analyses can 
be performed using the standard tools:

• Pop-up menus 

• Analysis > Impact or Analysis > Trace 

• Layout DXL 



Using Telelogic DOORS for ClearCase Interface           19

Import exceptions

• Analysis > Wizard 

The Analysis Wizard is particularly good for creating customized traceability 
reports. With this, you could create a report that shows the relationship between 
change requests and code check-ins, showing complete version names in the 
context of the change requests. 
Links can be deleted using any of the standard techniques. 

Applications of imported structures 

DOORS can be used to store any kind of structured information, so it is likely 
that you already have information that can be usefully linked to the configuration 
items. In addition to the classic application of requirements traceability, you can 
also build links from change requests, bug reports, design information, test plans 
and project plans to ClearCase versions. 
Once in place, you can demonstrate that specific changes have been 
implemented, or create reports that justify all checked in changes. 
Another application is the creation of complete product manifests. Using the 
DOORS export functions, you can create documents in Word, HTML or any 
other supported format, that lists the document version included in a shipment.

Import exceptions 
The Telelogic DOORS for ClearCase Interface import process is designed to 
import the information that you need most in your DOORS-based lifecycle 
traceability scheme. To this end there are some items that are not imported. Two 
items that are deliberately not imported are listed below.

• Any version that is checked out is not imported until it is checked in. Any 
item that would be selected only with a \CHECKEDOUT configuration 
specification rule is specifically ignored. If a checked in item has been 
merged with an item that is still checked out the CC Merges attribute 
contains the reference; for example \main\CHECKEDOUT. However, 
no DOORS link is created until the merge target is checked in. 

• Versions of directory elements are not imported. Telelogic DOORS for 
ClearCase Interface only imports from the directories that are selected by 
the configuration specification of the view from which you import.

Private files and derived objects from multiple views can be imported by 
repeating the import process from those different views. If there are several 
elements of the same name, Telelogic DOORS for ClearCase Interface has no 
way of distinguishing them; it then considers each private one an update of an 
earlier import.
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4 Labelling DOORS baselines
This chapter describes:

• Importing ClearCase labels into DOORS

• Creating DOORS baselines

• Understanding results

• Using DOORS traceability

Importing ClearCase labels into DOORS 
ClearCase labels are typically used to mark which files were included in a 
particular release. Labels have names, such as Release_3, which can be attached 
to versions of ClearCase elements. Labels can be attached to any version, and do 
not restrain in any way the numbering system.
DOORS baselines create frozen versions of modules that are similar to 
checked-in versions of files: they can be referenced, but not changed. Baselines 
are numbered progressively using major and minor versions, plus a textual suffix.
ClearCase labels are ideal for use as DOORS baseline suffixes, where they can be 
used for the same purpose as in ClearCase. This is the main function of the 
Telelogic DOORS for ClearCase Interface baseline labelling function.
Baseline labelling is a two-step process: importing labels and creating baselines. 
The import process sets up a structure where a record of each created baseline is 
kept. This section describes the import step while the section “Creating DOORS 
baselines,” on page 24 describes baseline creation.
Even though labels are directly related to a VOB, access to ClearCase is still 
controlled by views. For these reasons you must choose a view for your import 
operation.

Importing labels for the first time 

You can choose to import into an empty module or into a module that already 
contains objects. The set of labels from each VOB is always imported under its 
own top-level object. 
Normally, you would maintain your label and baseline structure in a special 
module, though you might choose to store label information for several VOBs in 
the same module. If you choose to do this, the new VOB will be imported under 
a new level one object at the end of the module. 
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It is advisable not to store label and baseline information in the same module as 
the imported ClearCase configuration structure. 
To import labels from ClearCase: 
1. Log in to DOORS as a Database Manager, a Project Manager, or a Custom 

user with the power to archive data. 

2. Open your target DOORS module. 

3. Select DOORSConnect > ClearCase > Label baselines. 

A command prompt window (DOS box) appears briefly before the Import 
ClearCase Labels window appears. This happens when Telelogic DOORS 
for ClearCase Interface is communicating with ClearCase.

If you want to import from a dynamic-view make sure that the Drive field 
contains the correct drive. M: is the ClearCase default. 

4. Select the view in the View field. 

5. Select the VOB in the VOB field. The Path field shows the composite path 
that you have created.

Note  Only mounted VOBs and views are shown. If you do 
not see the VOB or view you want to import, click Close 
to quit Telelogic DOORS for ClearCase Interface, then 
use ClearCase to mount the required VOB and view.
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Importing ClearCase labels into DOORS

6. If you want to import from a snapshot view or a dynamic view mounted on 
a specific drive, select Specific view drive from the Type drop-down list.

7. Select the correct drive and VOB. The Path field shows the composite path 
that you have created.

Note  Only mounted VOBs are shown. If you do not see the 
VOB you want to import, click Close to quit Telelogic 
DOORS for ClearCase Interface, then use ClearCase to 
mount the required VOB. 

8. Click Import to start the import operation. 

A command prompt window appears briefly. 

9. When the import is complete, the DOORS module is updated and the 
Apply Label to Modules window is displayed. For further information, see 
“Creating DOORS baselines,” on page 24. 

The following screenshot shows the label module after importing labels:
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Re-importing labels 

It is likely that after you have completed this baseline labelling operation you will 
create more ClearCase labels. For this reason, Telelogic DOORS for ClearCase 
Interface can synchronize existing imported labels with the state of the 
ClearCase VOB, adding new labels as required.
To do this, select the VOB object at the top of the label and baseline structure, 
then repeat the procedure in “Importing labels for the first time,” on page 21.

Imported attributes for labels
ClearCase data is stored in DOORS attributes when it is imported. Attributes 
that store ClearCase data start with CC.
ClearCase properties are stored in the following attributes:

Creating DOORS baselines
The second step of the import process is the creation of DOORS baselines using 
an imported ClearCase label.

Attribute Meaning

Object Heading The name of the ClearCase label.

Object Text The ClearCase comment for the label, specified when the 
label was created.

CC Kind The object type. Possible values are VOB, Label and 
Baseline.

CC User The name of the person who created the label.

CC Date The date on which the label was created.
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Creating DOORS baselines

You create baselines using the ClearCase Apply Label to Modules dialog box: 

To create labeled baselines: 
1. Ensure all necessary DOORS modules are closed and not in use by others. 

2. Select the required label from the list in ClearCase labels.
3. Select the required module from the list in DOORS modules. You can 

select any number of modules in this list. Use Select all and Clear all to 
simplify the selection process if you have a lot of modules.

4. Select the type of baseline required: Suffix only, Minor or Major version.

5. Select whether you want to include a suffix by clicking Use suffix. The 
default suffix is the selected ClearCase label. You can modify it before use if 
required.

6. Modify the label comment, if necessary. It is used as annotation for the 
baseline.
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The following screenshot shows another example of the ClearCase Apply 
Label to Modules dialog box:

7. Click Baseline. You are asked to confirm the operation twice. To create the 
baseline, DOORS needs to open all the selected modules in exclusive edit 
mode. This means you must make sure that no one else has any of the 
modules open in either exclusive or shareable edit modes. 

Once a baseline has been created, it cannot be destroyed or recreated, so you 
must be absolutely certain that a group baselining operation is correct before 
proceeding. 
Baselines are created for each of the specified modules, and the label module is 
updated to contain a baseline-creation object for each module. 
The attribute CC Baseline is created and filled with the baseline name for each 
baseline creation object.
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Understanding results

When the baseline creation is complete, the following Baseline Labelling Report 
dialog box is displayed: 

This window shows how many labels and baselines were created.
For further information on how to use the Baseline Labelling Report window 
functions, see “Understanding results,” on page 27.

Understanding results
All the normal DOORS viewing mechanisms can be used on the label and 
baseline structure. The information can be displayed in either document or 
graphics mode. Each object type has been allocated a color to aid visual 
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identification. The following screenshot shows module baseline records created 
in document mode:

Graphics colors

When each item is imported it is assigned a color for use in graphics mode. This 
helps provide instant visual recognition of the structure of your data.
The color allocations are as follows:

Kind Color

VOB Red

Label Green

Baseline Blue

Derived Object Pink

Private File Orange
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Understanding results

The following screenshot shows module baseline records in graphics mode:

Viewing new information 

If you re-import labels or create new labels in the same module, you can use the 
Apply filter button on the Baseline Labelling Report dialog box so that only the 
new items are displayed, as shown in the following screenshots: 
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The following screenshot shows the DOORS Open Baseline window for a 
baseline created using a ClearCase label and comment: 

Using DOORS traceability
By storing information on labels and baselines in a DOORS module, they can be 
included in your traceability schema. In this way you can link details of released 
information directly to project plans and other applications, as outlined below.
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Using DOORS traceability

Managing links

You can use any of the following standard methods for creating links between 
label and baseline objects and other DOORS information:

• Drag and drop

• Link > Create links
• Link module matrix

In each case you must take into account the correct direction for links to allow 
impact and traceability analyses to be performed as required. These analyses can 
be performed using the following standard tools:

• Pop-up menus

• Analysis > Impact or Analysis > Trace
• Layout DXL

• Analysis > Wizard
The last item, the analysis wizard, is particularly good for creating customized 
traceability reports. With this, you could create a report that shows the 
relationship between code check-ins and module baselines, showing complete 
version names, baseline specifications, and dates in the context of planning 
information.
Links can be deleted by using any of the standard techniques.

Applications of imported labels 
DOORS can be used to store any kind of structured information, so it is highly 
likely that in your data you already have information that can be linked to 
baseline records. You might use it to associate particular module baselines with 
deliveries made to customers with specific requirements. 
Another application is to create complete product manifests. Using the DOORS 
export functions, you can create documents in Word, HTML or any other 
supported format, that lists the document version included in a shipment.
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5 Troubleshooting
• If you experience poor performance when importing data to DOORS

If you experience poor performance when importing data to DOORS
When importing data from ClearCase into DOORS, the operation may take a 
long time and may appear to hang.
To resolve this problem, do the following before importing:

1. Open up Windows Task Manager.

2. Go to the Processes tab.

3. Right-click on the doors.exe process and for the Set priority menu option, 
click low.

4. Try the operation in the integration again.

5. Once the import operation has finished, set the priority of the process back 
to normal.
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6 Contacting support
This chapter contains the following topics:

• Contacting IBM Rational Software Support

• What to do before you contact Support

• Sending an automated problem report form

• Other information

Contacting IBM Rational Software Support
Support and information for Telelogic products is currently being transitioned 
from the Telelogic Support site to the IBM Rational Software Support site. 
During this transition phase, your product support location depends on your 
customer history.

Product support
• If you are a heritage customer, meaning you were a Telelogic customer prior 

to November 1, 2008, please visit the DOORS Support Web site on 
https://support.telelogic.com/doors.

Telelogic customers will be redirected automatically to the IBM Rational 
Software Support site after the product information has been migrated.

• If you are a new Rational customer, meaning you did not have 
Telelogic-licensed products prior to November 1, 2008, please visit the IBM 
Rational Software Support site on 
http://www.ibm.com/software/rational/support/.

What to do before you contact Support
If your site has a designated on-site support person, please contact that person 
before you contact our Support team.
To help our Support team solve your problem, please have the following 
information available:

• Your name, title, company name, e-mail address, fax number and telephone 
number.

• Your support ID and support password.

• The version and build number of DOORS that you’re running.
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To get this information, run DOORS, and click Help > About DOORS.

• The operating system you’re running DOORS on, for example Windows 
XP.

• What operating system your DOORS database is running on, if different.

• If you are reporting a new problem, please have a clear statement of the 
problem, including the exact text of any error messages produced by 
DOORS, your operating system, or any other tools that were running when 
the problem occurred.

• If you are calling about a problem you reported earlier, you need the original 
tracking number the Support team assigned to your problem.

• If you want, you can use the automated problem report form. For 
information, see “Sending an automated problem report form,” on page 36.

The support center on our web site is at https://support.telelogic.com.

Sending an automated problem report form
To send an automated problem report to Support:
1. Select Help > Generate Support Request.

The Telelogic Support Information dialog box is displayed with some of 
your product information automatically included.

Review the information to make sure it’s accurate.

2. From the Impact drop down list box, select the severity of the problem.

3. In the Summary box, summarize the problem.

4. In the Problem box, type a detailed description of the problem.

5. If available, attach a snapshot.

Click either DOORS Window Snapshot or Screen Snapshot, whichever is 
applicable, and select the snapshot from your machine.

6. If possible, use the buttons in the Attachment Information area to add 
video capture, system details and files.

Note  The Add Product Files button is unavailable in 
DOORS. Product information is collected and added 
automatically.

Add any relevant information to help Support resolve the problem.

7. You can either:
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Sending an automated problem report form

• Display the information you’ve entered in a new window so that you can 
copy it. For example, you may want to add this information to someone 
else’s information. 

Click Just Text (No Email).
• Open the email to edit it before sending it to Support. 

Click Preview and Send to submit the report.

Guidelines for writing a problem report

• Be as specific as possible when you summarize the problem in the 
Summary box and when you explain the situation and provide details in the 
Problem box. For example, “The system crashed when I tried to add an 
attribute” is more helpful than “It crashed.”

• Indicate if there were any system changes, such as customizations or 
upgrades, before the problem occurred.

• If the problem is reproducible, list the specific steps to be followed in order 
to demonstrate the problem and also indicate the model you are using to 
perform the steps.

• In the problem description, include anything different or unusual that you 
observed before the problem happened.

• Make screen captures of anything that you feel will help and attach them to 
the problem report.

• Include any error messages and code samples you have related to the 
problem.

• If you have multiple unrelated questions or issues, please submit them 
separately. 

Automatic responses and recording defects

When you send the online form to Support, the customer service system 
immediately searches the Knowledge Base based on the Summary and 
Problem descriptions you entered. If there is an exact match of your problem in 
the knowledge base, the system automatically sends an email to you with a 
pointer to the most likely solution.
The problem is also automatically recorded in the defect tracking system as 
assigned to a support representative. This representative works with you to be 
certain that your problem is solved. The defect tracking system also records new 
problems with their solutions in the Knowledge Base to provide rapid assistance 
for other customers.
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Automatically generated problem reports

If your DOORS system crashes, it displays a message asking if you want to send 
a problem report about the crash to DOORS Support.
If you decide to send this generated report, the system displays the same online 
form that is available from Help > Generate Support Request. In this case, 
the form contains information about the crash condition, in addition to the 
information that is usually filled in describing your system. 
Add any more information that you can to help the Support staff identify the 
problem before you click the Preview and Send button.

Changing the email address of the problem report
If you want to send the problem to someone other than DOORS Support, for 
example to your internal support, you can change the default email address of 
the problem report.
To change the email address of the problem report:
1. Open System in the Control Panel.
2. On the Advanced tab, click Environment Variables, then click New under 

variables.

The New User Variable window is displayed

3. In Variable Name enter ILX_RECIP, the variable that controls the 
address used by the problem report.

4. In Variable Value enter the email address you want to use.

5. Click OK to add the value.
6. Click OK to save the value in the environment variables.
7. Click OK to save the value in the system properties.

Other information
For Rational software product news, events, and other information, visit the 
IBM Rational Software Web site on http://www.ibm.com/software/rational/.
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7 Notices
This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right 
may be used instead. However, it is the user's responsibility to evaluate and verify 
the operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to:  
 
IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  
 
For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to:  
 
IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan  
 
The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
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This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between independently 
created programs and other programs (including this one) and (ii) the mutual use 
of the information which has been exchanged, should contact:  
 
Intellectual Property Dept. for Rational Software 
IBM Corporation 
1 Rogers Street 
Cambridge, Massachusetts 02142 
U.S.A. 
 
Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
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Trademarks

performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 
Additional legal notices are described in the legal_information.html file that is 
included in your software installation.

Trademarks
IBM, the IBM logo, ibm.com, Telelogic, Telelogic DOORS, and Telelogic 
DOORS for ClearCase Interface are trademarks or registered trademarks of 
International Business Machines Corporation in the United States, other 
countries, or both. These and other IBM trademarked terms are marked on their 
first occurrence in this information with the appropriate symbol (® or ™), 
indicating US registered or common law trademarks owned by IBM at the time 
this information was published. Such trademarks may also be registered or 
common law trademarks in other countries. A current list of IBM trademarks is 
available on the Web at www.ibm.com/legal/copytrade.html.
Microsoft, Windows, and/or other Microsoft products referenced herein are 
either trademarks or registered trademarks of Microsoft Corporation.
Other company, product or service names may be trademarks or service marks 
of others.



Notices

42    Using Telelogic DOORS for ClearCase Interface



Index

A
attributes

imported elements,   16
imported labels,   24
imported structures,   9

automated problem report form,   36

B
baselines

about displaying,   27
creating,   24
graphics mode,   16, 28

E
exceptions,   19

G
graphics mode,   16, 28

I
IBM Customer Support,   35
ILX_RECIP,   38
import exceptions,   19
imported information

about labels,   17
attributes,   16
color allocation,   16, 28
displaying,   10
filtering,   29
understanding,   13
version structures,   13

imported labels
about,   17
about importing,   21
attributes,   24
importing for the first time,   21
updating,   24

imported structures
attributes,   9
importing for the first time,   5
updating,   8

importing
about importing labels,   21
about importing structures,   5
attributes for imported labels,   24
attributes for imported structures,   9
displaying imported information,   10
importing labels for the first time,   21
importing structures for the first 

time,   5
updating labels,   24
updating structures,   8

L
links,   18, 31

M
merge links,   18

S
support,   36

T
Telelogic DOORS for ClearCase Interface

functions,   3
introduction,   3

traceability,   18, 30

V
Versioned Object Bases (VOBs),   4



Index

44    Using Telelogic DOORS for ClearCase Interface


	Table of contents
	About this manual
	Typographical conventions
	Related documentation

	Concepts
	About Telelogic DOORS for ClearCase Interface
	About Telelogic DOORS for ClearCase Interface functions

	Importing from ClearCase
	Importing from ClearCase into DOORS
	Importing structures for the first time
	Re-importing structures
	Imported attributes for structures

	Viewing new information
	Understanding imported information
	Version structure
	Graphics colors
	ClearCase attributes
	Labels
	Merge links

	Using DOORS traceability
	Managing links
	Applications of imported structures

	Import exceptions

	Labelling DOORS baselines
	Importing ClearCase labels into DOORS
	Importing labels for the first time
	Re-importing labels
	Imported attributes for labels

	Creating DOORS baselines
	Understanding results
	Graphics colors
	Viewing new information

	Using DOORS traceability
	Managing links
	Applications of imported labels


	Troubleshooting
	If you experience poor performance when importing data to DOORS

	Contacting support
	Contacting IBM Rational Software Support
	Product support

	What to do before you contact Support
	Sending an automated problem report form
	Guidelines for writing a problem report
	Automatic responses and recording defects
	Automatically generated problem reports
	Changing the email address of the problem report

	Other information

	Notices
	Trademarks

	Index

